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Photoshop World 2021 
Making Lightroom Classic Haul Butt: Optimizing Your Workflow 
By Rob Sylvan 
 
One of the fundamental principles behind Lightroom Classic’s existence is to make a photographer’s 
workflow more efficient. To this end, there are a variety of settings, features, functions, tasks, and ways 
of thinking that can help you optimize your workflow to suit your needs. Join Rob as he explains how to 
get the most performance out of the system you have, demonstrates key features within a typical 
workflow that will help you become more efficient, and shows you a variety of tips and tricks that save 
you time and help you feel more in control. 

 
We love LrC for the power of the Develop module, but there is so much more to love about 
how it can streamline our entire post processing and asset management workflows. In this 
session I’m going to share some of my favorite practices for becoming more efficient. One of 
LrC's greatest strengths is its ability to help you create a consistent foundation to your workflow 
that saves you time through its efficiency and gives you dependable results. In fact, there’s a 
number of things you can do right from the start that will help you create a more consistent 
workflow. In concert with all of the tips and techniques I will share in this session, I can’t stress 
strongly enough that you start with a walk through of this fantastic document published by 
Adobe for optimizing Lightroom Classic. That document will answer your questions about 
hardware, key preference settings, and more. Putting those tips and these practices together 
will truly supercharge your experience. 

Making the Most of Lightroom Classic's Interface 

LrC’s interface isn’t as customizable as Photoshop’s, but it can be changed in a number of ways 
to maximize the space devoted to your photos, to make your workflow more efficient, and to 
hide the parts you just don’t use very often. 

Panel Groups 

There are four main panels that appear in all 
LrC modules. They can be manipulated as 
needed to allow you to control the size of the 
center workspace where your photos appear, 
as well as to only reveal the set of tools 
required for the task at hand. These four 
panels are called the Left Panel Group, Right 
Panel Group, Module Picker (top), and Filmstrip (bottom). 

https://helpx.adobe.com/lightroom-classic/kb/optimize-performance-lightroom.html
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Each of these panels can be collapsed 
completely by clicking the outside edge of the 
panel (you don’t need to click the actual arrow 
on the outside edge). However, if you right-
click the outside edge you’ll get a contextual 
menu that gives you a greater level of control. 
 
I find the default option of Auto Hide & Show a 
little annoying as it will automatically show the 
panel if your cursor gets too close to the edge, 
and this happens too often for my taste. If I 
need to collapse a panel group, I prefer to set 
each panel to Auto Hide instead. When you 
choose Auto Hide the panel automatically 
collapses and it won’t expand again until you 
manually click that panel’s outside edge. The 
panel will then appear at a low opacity and 
allow you to access everything inside that 
panel, but as soon as you move your cursor off 
the panel it automatically hides again. This 

really helps me maximize the space devoted to my photos. 
 
Of course, as with most things in Lightroom, there’s more than one way to get the job done. 
There are keyboard shortcuts for hiding/showing each panel group, but instead of giving you 
each one I recommend checking out the complete list of all shortcuts. You can also go to the 
Help > [ModuleName] Shortcuts menu, where you’ll find the keyboard shortcuts listed for the 
module you are viewing. 
 
That said, there are two keyboard shortcuts I use all the time that are easy to remember. The 
first is pressing Tab to show/hide both the left and right panel groups simultaneously. The 
second is pressing Shift+Tab to show/hide all four main panels at once. 
 
While you may most often want to collapse panels to get them out of the way you can also click 
the inside edge and drag inward to make the left and/or right panels wider. I often make the 
right panel group in the Develop module wider to get a finer level of control on the sliders. 
 
Similarly, you can make the Filmstrip taller or shorter by clicking the edge just below the 
Toolbar and dragging up or down (respectively). Note, if you make the Filmstrip too small the 
icons that appear on the thumbnails will go away. 

Individual Panels 

Now that you have a handle on how to manage the larger panels, let’s take a look at what you 
can do with the smaller panels contained within the Left and Right Panel Groups. 

https://helpx.adobe.com/lightroom-classic/help/keyboard-shortcuts.html
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To cut down on the amount of scrolling you do in a day, as well as to only reveal the tools you 
need for a given job, you can expand or collapse each individual panel by clicking on each panel 
header (not just the arrow). As an alternative, you can Mac: CMD-click / Win: Ctrl-click any 
panel header to expand or collapse all the panels on that side in one fell swoop. 
 
A really neat trick is to Mac: Option-click / Win: Alt-click any panel header to engage what is 
called Solo Mode. With Solo Mode enabled you’ll only be able to open a single panel within the 
larger panel group at a time. This makes it very easy to switch between panels with a minimum 
amount (if any) scrolling. As soon as you expand a new panel the last one you were using 
automatically collapses. Mac: Option-click / Win: Alt-click any panel header a second time to 
disengage Solo Mode. Note that while the Navigator, Histogram, and Preview panels within the 
various modules can be collapsed or expanded individually, they are not included in Solo Mode 
or the expand all/hide all commands. 
 
One panel option that most people seem to 
find by accident is the ability to completely 
remove a given panel from the panel group 
so that you no longer even see its header 
label. If you right-click any panel header—
except the ones noted above—you can 
simply uncheck any panel from the 
contextual menu that appears and it will 
disappear from the group. Just re-check 
that panel in the menu to bring it back. You 
can also restore panels from the Window > 
Panels menu. Later on we’ll look at a 
special trick for reordering panels in the 
Develop module. Note the command for Solo Mode lives in there too. 
 

You have the same level of 
control up in the Module Picker 
too. Just ctrl-click/right-click 
the Module Picker and uncheck 
any module you no longer 
want to see listed there. 
 
This doesn’t remove the 

module completely, just removes its button from the Module Picker. 

Screen Modes 

Taking a step back to look at the interface as a whole we also have the ability to switch 
between a few different screen modes. You can find all of the modes listed under Window > 
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Screen Mode, along with their respective keyboard shortcuts. The most important thing you 
need to know is that you can cycle through them all one at a time by pressing Shift+F. I also 
want to point out that you can still access the menu bar while in Full Screen mode. 
 
Just move your cursor to the very top of the screen and the menu bar will pop down 
automatically. To see a single image full screen (called, “Full Screen Preview”) press the F key, 
which is really handy when you want to clear all clutter and just see nothing but your photo 
filling the screen. 

Lights Out 

One last trick up your interface sleeve is Lights Out mode. Lights Out comes in three flavors; 
Lights On, Lights Dim, and Lights Off. Lights On is the default and what you use all the time. 
Press the L key once to transition to Lights Dim, where the selected photo(s) remains at full 
brightness, but the interface dims. Press the L key again to transition to Lights Off where the 
interface fades to black completely. I love using Lights Off in conjunction with the Crop Tool to 
get a real time preview of the final crop. On the Interface tab of the Preferences, you can set 
the Dim Level and even change the Lights Out color from black if you wish. Press L one last time 
to turn the lights back on. 
 
Everything you learn about the interface extends throughout all of the modules within LrC, so 
the more proficient you get, the more it helps you as you move through your workflow. Let’s 
take a quick look at a few tips to help you through the import process. 

Import Tips 

The main goal of every import process is to introduce your photos to the LrC catalog. The most 
important piece of information added to the catalog at this time is the exact location for where 
your photo is stored on the destination drive. You can of course use LrC to move photos to new 
locations after import, which keeps the path stored in the catalog up to date as well as relocate 
your photos. The most frequent form of import is where we are copying photos from a memory 
card to a destination drive, and any type of repeatable behavior is a good candidate for 
standardization to increase efficiency. LrC is good at helping us select the correct source when 
importing from a memory card, so let’s look at other key items. 

Use Embedded and Sidecar 

The Embedded and Sidecar option can be found in the File Handling panel. This was an addition 
that slipped into LrC a while ago, but I’ve been using it ever since and I love how much faster it 
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makes the import process. Expand the 
File Handling panel and choose 
Embedded & Sidecar from the Build 
Previews drop-down menu. This tells 
Lightroom to import the embedded JPG 
from the raw photo (or accompanying 
JPG if you shoot raw+JPG and there isn’t 
a large enough embedded preview) to 
display as the preview you see in Library. 
This makes going through and making 
your initial selects (see my PUXZ tip later) 
much faster because you don’t have to 
wait for LrC to render all new 
previews. LrC will quietly update the previews during idle time or when you switch to Develop. 

Consistent Naming Practices 

I don’t believe that there is a single right way to name files and folders, but as long as the 
method you choose makes sense to you (most importantly) and it can scale up over time, then 
that should do the trick. LrC can help you with both of these jobs, so let’s look at folder names 
first. 

Folder Naming 

I like to use LrC to create folders as part of the import process, and I also like to use the 
automated date-based folder name structure as it scales nicely into the future without me 

having to do anything more. The one thing I don’t like 
about LrC’s automated folder naming functionality is 
that you can’t customize the date-generated names to 
include more than just a date. However, this limitation 
is easily overcome after import. Here’s my approach: 
 
Step One: In the Destination panel of the Import dialog 
set the Organize option to By date and choose a Date 
Format that suits your needs. 
 
Step Two: Select the parent folder where you want LrC 
to create these date-based subfolders. 
 
Note: LrC creates the subfolders based on the capture 
date of the photos being imported, and these new 
folders will appear in the Destination panel in an 
italicized font. 
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Step Three: Configure the rest of the 
Import dialog options and click the Import 
button. 
 
Once the import process is complete you’ll 
see the new folder(s) appear in the Folders 
panel. At this point I’ve got the date-based 
folders, which is great, but I also want to 
add a descriptive word or two to the folder 
name to help me know what the folder 
contains. This is easily done simply by ctrl-
clicking (PC: right-clicking) the folder name 
and choosing Rename from the contextual 
menu that appears. This opens the Rename 
Folder dialog box where you can add a word or two and click Save, which renames the folder on 
your drive and updates the catalog to reflect this change. 
 
For me, this process gives me the best of all worlds, which is an automated process that 
contains meaningful information and scales nicely into the future. 

File Naming 

When it comes to individual file names I also look to LrC to automate the process. Again, this is 
an area with a lot of room for individual customization as we all have our own needs to fill, but 
the basic process starts with creating a custom filename template that includes the information 
that is important to you. Once you create a filename template you can configure it to be 
applied from the File Renaming panel of the import screen, or you can apply it at will from the 
Library module after import. You’ll need to decide where it suits your workflow best, but I know 
some people prefer to rename after import so that they can delete bad photos then rename all 
remaining files with a continuous sequence number that doesn’t contain any missing numbers. 
 
You can access the Filename Template Editor from any place you can rename photos. From the 
Library module, go to Library > Rename Photo(s), then click the File Naming drop-down menu in 
the Rename dialog box and choose Edit. From the Import screen, expand the File Renaming 
panel, click the Template drop-down menu and choose Edit. Once the editor is open the steps 
for creating a new template are the same. 
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Step One: Delete any existing 
tokens from the editing window 
to start fresh. 
 
Step Two: Choose any 
combination of tokens to create 
a template that suits your 
desired file name convention. 
 
Note: You can hard code data 
into the filename template 
simply by typing into the editing 
window. For example, I often 
enter a hyphen or underscore 
separator by typing this 
character between tokens. 
 
Step Three: Click the Preset 
drop-down menu and choose 
Save current settings as a new 
preset to save your template for 
reuse. Give it a meaningful 
name that represents the 
tokens used. 
 

A simple template I use consists of the Date token in YYYYMMDD format, followed by an 
underscore, followed by the Filename number suffix token (this is the camera generated 
sequence number without the three letter prefix), which is shown in the figure. These can be 
quite sophisticated, but I lean toward keeping it short and sweet. 

Consistent Metadata 

A metadata template containing your core contact and copyright information is another way to 
ensure you are consistently applying the same information to all of your photos. Once created 
this can easily by applied during import via the Apply During Import panel. You can create a 
Metadata template from the Import screen by clicking the Metadata drop-down menu and 
choosing New, or you can access the same editor from the Library module by going to 
Metadata > Edit Metadata Presets. 
 
Once the Edit Metadata Presets dialog is open you only want to enter information that apply to 
all photos equally. For me this includes all of the IPTC Copyright and IPTC Creator fields (with 
the exception of my street address). The one thing to keep in mind with this template is that 
you only want to check the box next to a field you are customizing with your own information, 
otherwise leave the boxes unchecked to retain any existing metadata that may exist. I have 
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seen some people make the mistake of checking the box for the GPS field only to find that this 
makes LrC ignore the data from that field. Similarly, make sure there is no unwanted 
information (like keywords way at the bottom) that you don’t want to include by accident. 
Once configured (and double-checked), click the Preset drop-down menu and choose Save 
current settings as a new preset to save it for reuse. 
 

 

Create an Import Preset 

Once you’ve configured the Import dialog with your new settings, click the Import Preset drop-
down menu (bottom-center of the Import dialog) and choose Save current settings as new 
preset. Give the preset a meaningful name and use that every import from now on. 
 

 
 
Once you are through the import process you land back in the Library module with your newly 
imported photos ready for you to go through and make your selects.  
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Making Selects (PUXZ) 

One of the best-kept secrets for improving speed in the process of separating the wheat from 
the chaff is the Auto Advance option under the Photo menu in the Library module. Give this a 
try, go to the Photo menu and check Auto Advance (it may already be checked), press the G key 
to jump to Grid view (if you are not there already), select a photo and apply a rating, a flag, or a 
color label to that photo. As soon as any one of those is applied (whether by keyboard shortcut 
or button click) LrC automatically advances focus to the next photo. This is a huge time saver!  
 
The most efficient way to utilize this is with keyboard shortcuts, and my favorites are P for pick, 
X for reject, and U for unflag. With Auto Advance enabled and those three keys I can very 
quickly move through a large volume of photos and end up identifying the ones I want to keep 
and the ones that will be deleted. If I come to a photo that I am on the fence about I use the U 
key, which doesn’t apply a flag but it will trigger Auto Advance to move me on to the next 
photo (think of it as a skip key). If you need to zoom in to check focus, just press and hold Z to 
zoom into 1:1 and then release the Z key to return to grid view and continue flagging away. 
With all of your flags (or star ratings) applied, take advantage of the various filtering options to 
help you move forward (check out my Photoshop World session on Getting Organized in 
Lightroom Classic to learn even more). 
 
Hopefully by now you’ve picked up some great tips for working smarter in the Library module, 
so let’s head over to Develop and further streamline our workflows. 

Consistent Develop Starting Place 

With your basic file management and metadata under control you can shift your attention 
toward creating a consistent default setting for your raw photos that can help your photos look 
more like they do in the camera right out of the gate and save you a lot of clicks down the road. 
This also allows you to save any Develop presets you might want to apply during import for 
more creative pursuits.  

What is the Raw Default? 

When you import raw photos into LrC some settings must be applied to the raw data to serve 
as a starting point for your edits. The un-customized settings are called the Adobe Defaults, 
which applies the Adobe Color camera profile, zeros out almost all other settings, and applies a 
baseline configuration of sharpening and noise reduction in the Detail panel. Note, this only 
affects raw photos, so you won’t see any changes to JPG, PSD, PNG, or TIF files (which do not 
have any settings at all applied to them by default). 
 
There’s nothing wrong with the Adobe Default settings, and there is nothing wrong with 
keeping them as-is. However, if you find that you always end up applying the same settings to 
all new raw photos (like lens correction or a specific camera profile or different sharpening 
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settings), then you might benefit from customizing the defaults to include your preferred 
settings. All this does is give you a new, and customized, starting point for your raw photos.  

Where is the Raw 
Default Set? 

The new system is found 
under Lightroom Classic > 
Preferences > Presets 
(PC: Edit > Preferences > 
Presets).  Here you will 
find an entirely new 
panel called Raw 
Defaults. The old method 
for customizing default 
settings has been 
removed. 
 
Within the Raw Defaults 
panel you have three 
basic options for the 
Master control: 
 
Adobe Default: The same Adobe defaults as we’ve had in the past. Adobe Color is the default 
profile, and most settings are zeroed out (with the exception of the sliders in the Detail panel). 
 
Camera Settings: The same as Adobe Default except that a profile will be selected to match 
your in-camera picture style selection (instead of Adobe Color). So, if you set your camera to 
shoot in B&W (monochrome), choosing Camera Settings would honor that and you will see that 
a monochrome profile has been applied. Note, unless you shoot with one of the Nikon Z series 
cameras, it just selects a matching profile and does not change any other settings. Nikon Z 
series owners may also see other settings in Basic and Detail panels change based on in-camera 
settings (hopefully we’ll see this extend to other camera makes and models in the future). This 
is an exciting new development, and I hope we see this idea of LrC doing a better job of 
emulating the in-camera settings continue to evolve. 
 
Preset: You choose a Develop preset that will be applied by default to all raw photos from all 
cameras (or just specific camera models). This will basically take the place of the old custom 
camera raw default option. You can include anything that you are able to include in a preset. 
You can also combine this with the Camera Settings option above. 
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Set the Master Default 

If you only have a single camera or you want all raw photos from all camera models to have the 
same base default settings, then customizing the Master setting is the first thing to do. In the 
old system we needed to create a custom default individually for all cameras even if we wanted 
to apply the same settings, so this is another improvement over the old system. Let’s imagine a 
few scenarios to help make sense of this. 
Scenario One: You don’t want to change anything at all. In this case, leave it set to Adobe 
Default. 
 
Scenario Two: You want to experiment with letting Lightroom Classic change the profile for all 
raw photos based on the in-camera picture style you choose, but leave all other settings the 
same as Adobe Default. In this case, choose Camera Settings from the Master drop-down 
menu. 
 
Scenario Three: You have a preset that you always apply on import, and you want to make that 
preset the new default for all raw photos, or you want to create a preset for this purpose and 
make that preset the raw default. In this case, you would use the Preset option in the Master 
drop-down menu to navigate to and select the desired preset. 

Create a Preset 

Let’s create a preset that simply enables the Auto settings function and leaves everything else 
at the Adobe Default, but also includes the new Camera Settings function for choosing a profile 
based on in-camera picture style. This is just an example, so feel free to include only the 
settings that make sense to your workflow. 
 



 
 

 12 

Step One: Select a raw photo and click the Reset button to ensure it is at the Adobe Default 
settings with everything zeroed out. 
 
Step Two: Go to Develop > New Preset to open the New Develop Preset dialog box. Name this 
preset Camera Settings Auto (or whatever makes sense to you). 
 
Step Three: Click the Group drop-down menu and create a new group called Raw Default 
Presets (or whatever makes sense to you). 
 
Step Four: Click the Check None box, and then only check the boxes for Auto Settings and 
Process Version. By not checking the box for Treatment & Profile Lightroom Classic uses the 
previously mentioned Camera Settings function for choosing the profile (and if you are shooting 
with a Nikon Z series, possibly some additional settings). Then click Create to complete the 
process. The new preset will appear in the Preset panel within the group you designated. 
 
Step Five: Go to the Presets tab of the Preferences, and click the Master drop-down menu, go 
to Preset, and select to the preset you created under the Presets menu (look for the preset 
group you designated). You should then see the name of your preset loaded in the Master 
drop-down menu. 
 
From this point forward, all newly imported raw photos will have the settings included in the 
preset applied to them by default. Likewise, clicking the Reset button in Develop will reset to 
the new default settings. Take some test photos with different in-camera picture styles applied, 
and then import them and give your new defaults a test drive. 

Updating The Preset 

After doing some testing you decide that you want to stick with the Camera Settings option for 
choosing profiles, but you don’t want to have Auto Settings applied AND you want to include a 
lens profile correction. Let’s update that preset. 
 
Step One: With a raw photo selected, click Reset to set to defaults. Then go to the Lens 
Corrections panel and check the boxes for Remove Chromatic Aberration and Enable Profile 
Corrections. Leave everything else at the default. 
 
Step Two: Right-click the Camera Settings Auto preset we created earlier (or whatever you 
named it), and choose Update with Current Settings to open the Update Develop Preset dialog 
box. 
 
Step Three: Only check boxes for Lens Profile Corrections, Chromatic Aberration, and Process 
Version. Leave every other box unchecked. Click Update. 
 
Go ahead and click the Reset button and the selected photo should retain the profile that 
matches the in-camera picture style, the tonal value sliders in the Basic panel should reset from 



 
 

 13 

Auto, and the boxes in the Lens Corrections panel should be checked. To update your default 
settings in the future, just update that preset. Note, be careful not to delete that preset or your 
defaults will revert to the Camera Settings option without telling you. 

Make Defaults Specific to Each Camera 

Now that you have a Master 
setting you like, what if you 
want to have a different default 
setting for one or more cameras 
you shoot with? In that case 
you’ll want to check the Use 
defaults specific to camera 
model checkbox under the 
Master drop-down menu. Once 
enabled, it brings the bottom 
section of the new panel to life. 
 
Using the Camera drop-down 
menu you can select the camera 
model you want to create a custom default setting for, then use the Default drop-down menu 
below that to choose from the same three options I outlined above, but for that specific camera 
only. Note, if at first you don’t see the desired camera model listed, exit the Preferences and 
view a folder or collection containing photos from the desired camera and return to this 
Preference setting. Once configured as desired, click the Create Default button to add that 
configuration to the panel. Note, if you need to set your defaults based on camera body serial 
number, check the Show serial number box and you’ll be able to choose each camera body 
individually. 
 
Once you’ve applied a camera specific default you can modify, update, or delete that setting via 
the drop-down menu at the far-right of the panel. Under that menu you will see options for 
choosing Adobe Default, Camera Settings, accessing all of your develop presets, or deleting that 
camera specific default setting. 
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You can of course still continue to apply a preset during import or when tethering or using Auto 
Import. The Raw Default setting you choose is applied first, then any import preset is applied on 
top of the default, and then anything you apply manually after import comes next. Think of the 
Raw Default as a time saving measure to get you to your preferred starting point. Think of 
import presets as creative or job specific additions to your default settings to get you to a 
different starting point. If all of this seems too overwhelming at first, just leave it at Adobe 
Defaults and do all your editing in Develop manually. There’s no wrong answer, just a few 
options to consider. 
 
One final note, the old shortcut for resetting to the Adobe defaults (useful if you had a custom 
default setting using the old method) has been discontinued in this latest update. So pressing 
Command + Shift + R (PC: Ctrl  + Shift + R) does the same as just pressing Reset, which is to 
reset the photo based on the settings you’ve chosen in the Raw Defaults section of the 
preferences. If you want a way to get to all zeroed settings and the Adobe Color profile, then 
you’ll want to create a preset that does that, and just click the preset when/if needed. 

Favorite Presets 

Another frequently used item in a LrC workflow are presets. If you press D to switch over to 
Develop and expand the Presets panel you may or may not see a Favorites folder at the top of 
the panel. You’ll only see it if you’ve marked some presets as a favorite. To do this, as you might 
imagine, you simply need to right-click a preset and choose Add to Favorites, which adds it to 
that preset group. 
 
You can remove a preset from being a favorite in the same manner. Note, presets marked as 
favorites will also be available in the Favorites preset group found in the Quick Develop panel 
and the Import window. 

Favorite Profiles 

https://lightroomkillertips.com/create-a-reset-to-zero-preset/
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The last thing I can think of that has risen to the level of being favorited are profiles. No hidden 
right-click involved for this one though. Simply open the Profile Browser in the Basic panel, then 
as you move your cursor over a profile you will see a little star icon. Clicking that icon adds the 
profile to your list of favorite profiles, which appears in the Profile drop-down menu and saves 
you from having to open the entire Profile Browser each time. 

Customize Develop Panel 

Back in the December 2018 update a new functionality was added to the panels in the Develop 
module, and I’ve been wondering how many people have taken advantage of this new feature? 
I admit to being so used to/comfortable with the default order that I’ve not made any change 
that I felt that strongly about. 
 
How does it work? Well, if you right-click any 
panel header on the right side of the Develop 
module (below the Histogram) you’ll see a 
contextual menu with Customize Develop 
Panel at the top. 
 
Click that to open the Customize Develop 
Panel dialog box, where you can change the 
vertical order of the panels on the right side. 
You can also uncheck the box next to any 
panel to hide that panel from view (though 
we’ve always been able to hide panels). 
 
Just click and drag the panels up and down to 
create any order that suits your workflow. The 
best I’ve come up with is sorting them from 
most frequently accessed to least (by me) 
from top to bottom. I can’t say as it has 
revolutionized my workflow, but I guess it 
makes a more logical workflow to me. 
 
 
Once you’ve arranged the panels to your liking, click the Save button at the bottom. You’ll be 
prompted to re-launch Lightroom for the change to take effect (or re-launch later if you are not 
ready to quit just yet). 
 
If you ever change your mind, just right-click one of the panel headers again and open the 
dialog back up. At the bottom is the Default Order button that will put the panels back to the 
way they were before. 
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I’ve been using Solo mode (also accessible via right-clicking a panel header) for years, which 
means I usually only have one panel open at a time, so it just wasn’t too much of a hardship to 
reach a little further for the desired panel. 

Consistent Output 

You’ve brought your photos into LrC’s care, you’ve processed them with your consistent style, 
and now you’re ready to send them out into the world. You can save yourself time here too by 
creating custom export presets that allow you to consistently reproduce the same results 
during output. Like me, you probably export copies for a wide variety of reasons, but there are 
probably some core destinations that you re-visit frequently, such as a regular client, an online 
lab, a stock agency, some photo sharing site, your blog, etc. In each of these cases the photos 
will vary, but the specifications the photos need to meet for each situation will stay the same. It 
is these cases that will benefit greatly from export presets. For example, when I export copies 
destined for Stocksy United, a stock photography co-op I belong to, I have an export preset that 
controls every parameter so I know that each submission is consistent with the previous ones. 
Here’s how to create your own: 
 
Step One: Select the photos for export and click the Export button. 
 
Step Two: Configure the Export dialog to contain only the settings needed for this specific 
output destination. 
 
Step Three: Click the Add button under the preset window to open the New Preset dialog box 
and give it a meaningful name. Optional: Store the preset in a folder for better organization of 
your presets. 
  
The best thing about creating export presets is that once you have them you can skip the Export 
dialog completely simply by going to the File > Export with Preset menu and selecting your 
desired preset. LrC does the rest just the way you configured it (While in that menu, note the 
export with previous shortcut if you do lot’s of similar exports without changing settings). 

Extending the Power of Lr Classic Export 

Output is such a huge part of LrC that it has four separate modules—Book, Slideshow, Print, 
and Web—entirely devoted to getting photos out in one form or another, then there are a 
number of publish service options, and finally there is the tried and true Export dialog. The 
Export dialog is the real unsung hero of LrC, and it is probably one of the functions you use the 
most. As powerful as the Export dialog is, you can expand its capabilities even further, and 
make your workflow more efficient than it is now. As an example, I want to share one of the 
ways I’ve upgraded my exports through the use of third-party export plug-ins that I rely on all of 
the time. 
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Lightroom Plug-in Manager 

All export plug-ins are installed through the same process and can be managed through the 
Lightroom Plug-in Manager. Let’s walk through the basics of where you can find these plug-ins, 
how to install them, how to remove them, and then how you can use one of them. To find the 
Plug-in Manager go to File > Plug-in Manager (or click the Plug-in Manager button on the Export 
dialog). 
 

 
 
You should see that you’ve already got a few plug-ins installed that come packaged with LrC. At 
the bottom left of the Plug-in Manager is a button that will take you to the Adobe Add-ons 
website, where you can try (and buy) many different types of add-ons for LrC (and other Adobe 
products). There are some useful ones there to check out, but my favorite plug-ins can all be 
found over at the Photographer’s Toolbox. No matter where you get your plug-in, here are the 
steps for installation: 
 
STEP ONE: Download the file to your computer and unzip to access the plug-in file, which will 
have a .lrplugin file extension. 
 
STEP TWO: Place a copy of that .lrplugin file in a folder of your choosing. I store mine in a folder 
located within my Creative Cloud files, but simply choose a location that makes sense for you. 
 
STEP THREE: Click the Add button on the Plug-in Manager and select the .lrplugin file you 
placed in that folder. Click the Add Plug-in button add it to the manager. 
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Many plug-ins have a free trial version available (or are just free) and the full version often only 
requires a donation. After adding the plug-in to the manager you will see if it has any special 
configuration requirements or a place to add the serial number for the full version. On the left 
you’ll see a green light next to the plug-in’s name that indicates it is installed and running. 
That’s all there is to it. To remove a plug-in added in this way just click the Remove button in 
the Plug-in Manager. Removing from the manager doesn’t delete the .lrplugin file from your 
computer, so you’d need to do that manually outside of Lightroom. 
 

Making Exports Zippy 
 
Here’s an example of why I think export plug-ins can be useful. I deliver files in compressed zip 
format all the time. It is such an easy and universally useable format for sending a files in a neat 
package that it has become habit for me. There’s a cool plug-in on the Photographer’s Toolbox 
called Zip Exporter that compresses your exported photos into a zip file right from the Export 
dialog (includes a free trial mode). You can even (optionally) configure the plug-in to upload 
that zip file to an FTP server as part of the process. The most common way I use it is to export 
the zip file to a folder in my Dropbox folder, and then I can easily send a link to that zip file via 
an email. 
 
Start by selecting the photos, then click the Export button. On the Export dialog, choose Zip 
Exporter from the Export To drop-down menu to access the panels for this plug-in. The only 
new panel provided by this plug-in is the one on the top named Zip Exporter, and it is here 
where you choose the location for this zip file to be created. I chose a folder in my Dropbox 
folder, but it is entirely up to you. Once you’ve chosen the location all you need to do is enter a 
name for the zip file itself before configuring the remaining panels based on your export needs 
for file type, size, color space, etc. like you would for any export. Once configured the way you 
want it, I highly recommend that you click the Add button under the preset window to save 
those settings as an Export Preset, which is a huge timesaver for any repetitive type of export 
you may have.  
 
Go further with Export Presets: 
 
Save Time with Export Presets - Lightroom Killer Tips 
https://lightroomkillertips.com/save-time-with-export-presets/ 
 
Batch Export Copies in Lightroom Classic - Lightroom Killer Tips 
https://lightroomkillertips.com/batch-export-copies-in-lightroom-classic/  
 

In Closing 

As you can see, from import to export, and everything in between, there are opportunities to 
leverage LrC’s presets, templates, and customizations to help you work smarter every step of 
the way. 

https://www.photographers-toolbox.com/
https://lightroomkillertips.com/save-time-with-export-presets/
https://lightroomkillertips.com/batch-export-copies-in-lightroom-classic/
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Please don’t hesitate to reach out to me with any questions. You can find me at any of the 
following locations: 
 
Twitter: @Lightroomers 
Facebook: @Sylvanworks 
Instagram: @Sylvanworks 
 
Web: Lightroomers.com or RobSylvan.com  

https://twitter.com/lightroomers
https://www.facebook.com/Sylvanworks/
https://www.instagram.com/sylvanworks/
https://lightroomers.com/
https://robsylvan.com/
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